Operation Manual for the EDS EZ Design Software

- A Melco Embroidery Design System for use with Microsoft® Windows® 3.x or Windows 95

Melco Embroidery Systems
A Saurer Group Company
# Table of Contents

## 1. How to use This Manual

<table>
<thead>
<tr>
<th>Scope of this Manual</th>
<th>1-1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Using Microsoft® Windows®</td>
<td>1-1</td>
</tr>
<tr>
<td>EDS EZ Help</td>
<td>1-1</td>
</tr>
</tbody>
</table>

## 2. Installing EDS EZ

<table>
<thead>
<tr>
<th>System Requirements</th>
<th>2-1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hardware Installation</td>
<td>2-1</td>
</tr>
<tr>
<td>Software Installation</td>
<td>2-4</td>
</tr>
<tr>
<td>Configuring EDS EZ</td>
<td>2-5</td>
</tr>
</tbody>
</table>

## 3. An EDS EZ Overview

<table>
<thead>
<tr>
<th>Starting EDS EZ</th>
<th>3-1</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Application Window</td>
<td>3-2</td>
</tr>
<tr>
<td>The Layout Window</td>
<td>3-3</td>
</tr>
</tbody>
</table>

## 4. Text Designs

| The Text Tool                    | 4-1 |

## 5. Working With Designs

<table>
<thead>
<tr>
<th>Designs as Objects</th>
<th>5-1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Modifying Condensed Designs</td>
<td>5-7</td>
</tr>
<tr>
<td>Modifying Expanded Designs</td>
<td>5-9</td>
</tr>
<tr>
<td>Print</td>
<td>5-10</td>
</tr>
<tr>
<td>Using the Color Palette</td>
<td>5-10</td>
</tr>
</tbody>
</table>

## 6. Working With Files

<table>
<thead>
<tr>
<th>Design Formats</th>
<th>6-1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Opening Designs</td>
<td>6-2</td>
</tr>
<tr>
<td>Importing Designs</td>
<td>6-3</td>
</tr>
<tr>
<td>Saving Designs</td>
<td>6-4</td>
</tr>
<tr>
<td>Exporting Designs</td>
<td>6-5</td>
</tr>
<tr>
<td>File Name Standards</td>
<td>6-6</td>
</tr>
</tbody>
</table>
7. Working With Peripherals

   Enabling the Peripheral 7-1
   Sending Designs 7-2
   Checking Peripheral Status 7-4

Index

Quick Reference Guide
1. How to use This Manual

Using Microsoft® Windows®
Windows has many useful features. Refer to the Microsoft Windows User’s Guide for more information.

EDS EZ Help
Online help allows you to access context-sensitive information. Information is available by pressing the F1 key. When you exit help, you are returned to your original position.
2. Installing EDS EZ

System Requirements
- 486/33 (ISA or EISA standards) with math co-processor and 8 MB memory
- 80 MB hard drive (controller board must have a Western Digital or Goldstar chipset to use Melco format disks)
- 3.5 inch disk drive, 1.44 MB capacity
- Super VGA Monitor 800 x 600, 16 color
- Melco Network Board
- Parallel port for Melco Security Dongle
- Mouse (Windows compatible)
- MS-DOS Ver 5.0 (or higher)
- Microsoft Windows Ver 3.1 (or higher) installed

You must completely install all included hardware and software using the procedures on the following pages.

Hardware Installation

Windows 3.x
If you are installing the system in Windows 3.x, install the card using the default jumper settings. Skip ahead to the section for installing the Network card.

Windows 95
If you are installing the system in Windows 95, install the card using the instructions below.

Check for Available IRQ and DMA settings
1. Click on Start→Settings→Control Panel.
2. Double-click on the System icon.
3. Select the Device Manager tab, the click Properties.
4. Make sure the Interrupt Request (IRQ) radio button is selected, then pick an IRQ that is NOT listed on the screen. Write down your IRQ.
5. Click the Direct Memory Access (DMA) radio button, then select a DMA that is NOT being used (the DMA must be either 0, 1, or 3). Write down your DMA.
Configure your card

Now you must transfer your settings to the Network card (if applicable). The IRQ defaults to 11, and the DMA (which comprises BOTH the DREQ and the DACK) defaults to 1. If you need to change these settings, make your changes to the card. Be sure to change BOTH the DREQ and DACK jumpers to change the value for the DMA.

Install the Network card

1. Turn the computer OFF and unplug it from the wall outlet. Remove the computer cover.

2. Discharge any static charge in your body by touching a non-painted area of the computer frame.

3. Locate an empty expansion card slot.

4. Remove the expansion slot cover to the rear of the computer.

5. Remove the network board from the anti-static shipping bag.

6. Make certain the jumpers are placed correctly.

7. Insert the network board into the slot and press down firmly until the board is seated evenly and completely.

8. Attach the network board to the rear of the computer frame with the screw from the cover removed in step 4.
9. Replace the computer cover.

10. Turn the computer on and start Windows.

Note: The following steps apply only to Windows 95 users.

11. Click on Start→Settings→Control Panel.


**Installing the Dongle**

The dongle is a security device that must be installed in an active parallel port of your computer.

1. Locate the parallel port LPT1 on the rear of your computer.

2. Turn the computer power OFF.

3. Secure the dongle with the captive screws.

Note: If you have a printer attached to your parallel port, remove the printer cable, attach the dongle, then reinstall the printer cable to the end of the dongle when installation is complete.

**Attaching the Peripheral**

See your embroidery peripheral operator manual for instructions on installing the network cable from the computer to the embroidery peripherals.

**Software Installation**

*Microsoft Windows must be installed prior to installing EDS EZ.* If Windows is not installed, refer to the Windows installation manual.

1. Insert the EDS EZ Program Disk 1 into the floppy disk drive.

2. Click on Start→Run (or File→Run if you are using Windows 3.x) to display the Run dialog box.

3. Browse to your 3½ floppy drive.

4. Select setup.exe and click Open (or OK if you are using Windows 3.x).

5. Click OK and follow the on-screen instructions to install EDS EZ.
A message will appear warning that EDS EZ must be configured before use. Configuration is covered in the next section.

When the message displays instructing you to reboot the system, remove the disk from the disk drive, exit Windows and turn your computer off. Wait 3 seconds and turn it on again.

### Configuring EDS EZ

Before starting EDS EZ for the first time, use the Config program to configure EDS EZ. Start Windows and follow these steps to configure EDS EZ:

1. Click on Start → Programs → Melco Apps → Config for Windows 95, or double-click on the config icon in the Melco Apps Group in Program Manager for Windows 3.x to display the EDS EZ Configuration dialog box.

2. Click on the Hardware button to display the Advanced Configuration dialog box.

3. Select the appropriate IRQ and DMA settings in the Network portion of the dialog box. The settings you select here **MUST** match your jumper settings on the card.

4. Click **Ok** twice to close both dialog boxes.

### Seeing Which Options are Installed

Click on Options in the Hardware Configuration dialog to display the Set Options information box. Options are in gray if installed or black if not installed.

**If you encounter problems during software installation, call Melco Telephone Support at (303) 457-2025 for assistance.**

---

**Figure 2-3**

**Figure 2-4**
3. An EDS EZ Overview

This chapter provides an overview of the operation and features of EDS EZ.

Starting EDS EZ

![Figure 3-1](image1)

Double click here to start EDS EZ

![Figure 3-2](image2)

The Application window appears when EDS EZ is started
The Application Window

The Application window is the first screen EDS EZ displays. It has File, Peripheral, and Help in its menu bar. Using these you can:

- Open a new layout window
- Open a file from a disk
- Import designs from non-DOS disks
- Send designs from the hard drive to the peripheral

**File**

Click on File in the menu bar and a drop-down menu (Figure 3-3) offers five options: New, Open, Import, Exit and a Design List.

**New** opens an empty Layout Window.

**Open** requests information for retrieving a DOS file. A more complete discussion of Open can be found in Chapter 7, “Working With Designs”.

**Import** requests information for retrieving a non-DOS file. **Exit** closes EDS EZ and returns you to the Windows program manager.

The **Design List** is at the bottom of the menu. The last six open files are listed here. Clicking on a name opens that design in the Layout Window.

**Peripheral**

Click on Peripheral to access the Transfer dialog box, which allows you to send .EXP or .ASD files directly to the peripheral.

**Help**

Provides information about the version of EDS EZ you are running. See Chapter 1 for more information on how to use help.

---

<table>
<thead>
<tr>
<th>File</th>
<th>Peripheral</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td></td>
</tr>
<tr>
<td>Open...</td>
<td></td>
</tr>
<tr>
<td>Import.</td>
<td></td>
</tr>
<tr>
<td>Exit</td>
<td></td>
</tr>
</tbody>
</table>

**Figure 3-3**

1. C:\EDSEZ\DESIGNS\UTCTEST.EXP
2. C:\EDSEZ\DESIGNS\JULY.CND
3. C:\EDSEZ\DESIGNS\FLAG.CND
4. C:\EDSEZ\DESIGNS\BUTRFLY.CND
5. C:\EDSEZ\DESIGNS\BIPPLANE.CND
6. C:\EDSEZ\DESIGNS\FLOWER.EXP
The Layout Window

Open the Layout window from the Application window by clicking on File then New. The menu bar options are: File, Edit, View, Peripheral, and Help.

From the Layout window shown in Figure 3-4 you can:

- Create lettering
- Add lettering to a design
- Open files from the hard disk and DOS format disks
- Import designs from paper tapes and non-DOS disk formats (Melco, Tajima, Barudan, Premier, and ZSK)
- Export designs to non-DOS formats and paper tapes
- Save design files to the hard drive
- Perform some customization of designs

The File Menu

Click on File in the menu bar and the drop-down menu (Figure 3-5) offers the following options; only the options in bold are available.

**New** opens an empty Layout window.

**Open** requests information for retrieving a DOS file. A more complete discussion of Open is in Chapter 7 "Working With Designs".

**Close** removes the design file from the active window.

**Save** allows you to save a new design or changes to an existing design. If you are saving for the first time, the Save As dialog box will appear and prompt you for a file name. If you are saving changes to an existing file, the original file will be overwritten.
Save As displays the Save As dialog box. It prompts you for information to save your current design as a new file, or a second copy of an existing file. If you change a design, you may want to keep both the original and the modified versions. Each must have a unique name.

Import displays the Import dialog box.

Export prompts you for information necessary to copy a design file to a non-DOS disk or paper tape.

Send transfers a design to a selected peripheral.

Print displays the Print dialog box.

Printer Setup prompts you for printer information. Clicking on Setup in the dialog box allows you to change or update information about the selected printer.

Exit terminates EDS EZ and returns you to the Windows Program Manager after giving you an opportunity to save any open files.

The Design List displays up to the last six opened designs.

The Edit Menu

Only commands in bold print are accessible (see Figure 3-6). Some grayed-out commands will be available in other windows or when screen objects are selected.

Center Design places the design’s center in the exact center of the peripheral’s sewing field. This is an important step before sending designs to be sewn.

Return to Origin is on when a check mark appears next to it. Activate this option by clicking on it. It returns the needle to its origination point when a design has finished sewing.

Cut, Copy, Paste and Clear are used to duplicate or delete designs or portions of designs.

<table>
<thead>
<tr>
<th></th>
<th>Edit</th>
<th>View</th>
<th>Peripheral</th>
</tr>
</thead>
<tbody>
<tr>
<td>Center Design</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Return to Origin</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cut</td>
<td>Shift+Del</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Copy</td>
<td>Ctrl+Ins</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Paste</td>
<td>Shift+Ins</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Clear</td>
<td>Del</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Figure 3-6
The View Menu

Only the bold commands in the View menu can be accessed (see Figure 3-7).

**Regenerate** redraws the design in the current window.

**Ruler** allows you to measure on-screen designs.

**Zoom In** enlarges a portion of the design on the screen. Select the area by clicking and dragging the magnifying glass cursor over it. This is useful for more precise editing. It does not affect sewing size.

**Zoom Out** decreases the design size on the screen. Select the area by clicking and dragging the magnifying glass cursor over it. It does not affect sewing size.

**Zoom Last** returns you to the previous Zoom view.

**Fit Window** redraws the design to fill the entire screen.

**Actual Size** draws the design on the screen at its sewing size.

**Show Zoom Factor** displays the current zoom factor on the status bar.

**Tool Bar** allows you to hide or display the toolbar.

**Status Bar** toggles the design information displayed at the bottom of the screen on and off.

**Design Status** displays stitch count, number of color changes, size of the design, and other statistics about the current design.

The Peripheral Menu

**Status** displays the Machine Status dialog box. This provides information on the status of the currently sewing job.
The Layout Toolbar

The options in the toolbar allow you to customize your design and work with other features of EDS EZ. They are represented by tools arranged down the left side of your screen as shown in Figure 3-8.

- The Text tool displays the Text dialog box where you create lettering objects for your designs.
- The Zoom In magnifying glass enables you to look more closely at a selected area of the current design.
- The Zoom Out magnifying glass enables you to see more of the current design.
- The Zoom Previous magnifying glass returns you to the previous zoom level.
- The Ruler tool allows you to measure a design in the Layout window.
- The Normal Cursor tool returns you to the standard arrow-type cursor.
4. Text Designs

Designs and alphabets are sometimes thought of as separate entities; but, alphabets are really a set of designs. Normally there is a design for each letter, number, and punctuation mark in the set.

The Text Tool
Creating text begins with the Text tool. Click on it and the Text dialog box displays.

The Text Dialog Box
The options in this dialog box affect the way your lettering displays on the screen and the way it embroiders.

![Figure 4-1](image_url)
Density

In the EDS EZ Text screen, the density box refers to the space between each line of stitching (see Figure 4-2). When this space is decreased, the lines of stitching per inch increases. To create more lines of stitching per inch, decrease the density value. A general rule of thumb is:

- As design size increases, density value should decrease
- As design size decreases, density value should increase

EDS EZ defaults to a density of 4.2 points (about 60 lines of stitching per inch). This is a useful density for many applications.

Note: Changing the density only affects column or satin stitches. Some alphabets are composed of fill stitches and changing the density will not alter their appearance.

Length

Length refers to the underlay, walking, or running stitches used to move from one area of sewing to another. These stitches are often covered by column stitching. Use the following as a guide:

<table>
<thead>
<tr>
<th>Lettering Size</th>
<th>Running Stitch Length</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.5 inch or greater</td>
<td>30-40 points</td>
</tr>
<tr>
<td>0.25 inch to 0.5 inch</td>
<td>25-30 points</td>
</tr>
<tr>
<td>0.25 inch or smaller</td>
<td>20-25 points</td>
</tr>
</tbody>
</table>
Line Type Options

There are five choices for line type:

- Line Center Middle
- Line Center Bottom
- Line Normal
- Arc Normal
- Arc From Center

You can sew in various types of arced or straight lines. Radius, Angle, CW and CCW are used when sewing the arc line types.

Line Center Middle

Line Center Middle centers lettering both horizontally and vertically around the needle starting and ending point (see Figure 4-4).

Line Center Bottom

Line Center Bottom centers lettering horizontally at the needle starting point, which becomes the lettering baseline (see Figures 4-5). In most alphabets the tails of the lower case letters such as g, j, p, q, and y extend below the baseline.

Line Normal

Line Normal starts the lettering at the current needle position, which is also the lettering baseline (see Figure 4-6). When the lettering is finished, the needle will not return to its original position.

Arc Normal

Arc Normal sews lettering in a curve. The needle starting position is the lettering baseline, with the text centered around the needle point (see Figure 4-7).

Arc From Center

With Arc From Center, the needle position prior to sewing is at the center of a circle that would be formed if the arc were completed. The first needle movement is from that center point to the circumference which is the lettering baseline (see Figure 4-8).
**Radius**

Radius controls the degree of curve in an arc (see Figure 4-9). An arc is part of a circle’s circumference or edge. The radius is the distance from the center of the circle to the circumference. The larger the radius, the flatter the curve.

Radius = 0.25 inch

Radius = 0.75 inch

Radius = 1.0 inch

**Angle**

Angle determines the location of the text center point. It is entered in degrees, with 0 at the top of a circle, and 180 at the bottom (see Figure 4-10).

**CW (Clockwise) and CCW (Counterclockwise)**

Figure 4-11 shows to sew in a clockwise direction when text is in the top half of a circle and counter-clockwise when text is in the lower half of a circle.
Spacing
Sometimes text is too crowded or too loosely spaced. This often happens to arc lettering (see Figure 4-12). Use the following techniques to adjust spacing.

Uniform Spacing
At the Text dialog box, locate Spacing in the middle right corner. Under Spacing is an option which allows you to increase or decrease the distance between all the letters in your text by a uniform amount. With letters of 0.75 inches in height, adding 0.10" helped the spacing, but the E M B letters at the lowest part of the arc are still too close. If more horizontal spacing is added, some of the other letters would be too far apart. Now customized spacing is needed.

Customized Spacing
Place the cursor between the letters needing space added, then press F8. A » symbol appears between the letters (Figure 4-14). Repeat as needed until spacing is adequate (Figure 4-15).

Each » adds a space equal to 1/16 of the letter height. For example, with a 1" letter the space would be 1/16". With a 0.5" letter, the space would be 1/32".

Deleting Space with the F7 Key
You can decrease the space between letters that are too far apart in a similar manner. In the Text dialog box, place the cursor between the letters that are too far apart and click. Press F7 and a « symbol appears between the letters. Click OK to move the letters closer together. Each « subtracts a space equal to 1/16 of the letter height.
Line Spacing

Line spacing is defined as the distance from the bottom of one line to the bottom of the next. A letter height of 1.0 inch with a line spacing of 1.0 inch makes the letters from each line touch (see Figure 4-16).

Use the following formula to determine line spacing:

\[
\text{Letter height} + \text{desired space between lines} = \text{Line Space}
\]

Vertical Spacing

Vertical spacing allows you to stair-step lettering up or down. (This feature cannot be used with Arc formats.) In the text dialog box, locate the Vertical option. This value defaults to 0.00. Change the value and click OK (see Figure 4-17). The top of each letter is to the right and above the previous letter by the amount of space designated.

Insert a negative value to stairstep down (see Figure 4-18).

Color Changes

A Color Change is an instruction to the peripheral to pause for a rethread on a single-needle machine, or to change to a different needle on a multi-needle machine. It also changes the color in the Layout window to the next color in the palette.

To add a Color Change in the Text dialog box, place the cursor between the letters and click, then press the F6 key. A ^ symbol marks the Color Change as
shown in Figure 4-19.

**Centering Text**

The Center Design command recenters your design in the center of your peripheral's sewing field. You can adjust the placement of the design at the peripheral before you begin to sew, but you should always perform this step before sending a design.

To center the design, Click on Edit→Center Design.

**Saving Text Designs**

To save a design:

1. Click on File→Save As. The Save As dialog box displays as shown in Figure 4-20.

2. Type a name for the design in the Save As File Name box.

3. Select a subdirectory (such as EDSEZ\DESIGNS) or drive by double-clicking on it in the Directories box. You can move back one level at a time by clicking on [..].

Note: If you do not select a subdirectory, your design will be saved in the EDS EZ main directory (EDSEZ).

4. Under File Type, click on Condensed, Object, or Expanded, then click on OK. File types are discussed in later chapters.
The name of your file is now displayed in the EDS EZ title bar. After the file has been named and saved once, you can resave the file and any modifications by clicking on Save.

**Monogramming**

You can create a monogram in EDS EZ using either a monogram alphabet or a regular alphabet in Monogram mode. Letters for monograms are entered from the Layout window using the Text tool and dialog box.

**Using a Monogram Alphabet**

To create a monogram using a monogram alphabet:

1. Click on the Text tool to display the text dialog box.
2. Select a Monogram Alphabet (for example, 3 LTR DIAMOND).
3. Type the initials (standard monogramming convention uses first, last, and middle initials in that order).
4. Type in the Height of the center letter. The heights of the other letters are controlled by the monogram alphabet.
5. Adjust the density as needed for the selected height.
Note: Do not click the monogram box when using monogram alphabets. It is used when monogramming with regular lettering alphabets.

6. Click on OK to display the monogram (see Figure 4-21).

**Monogramming With Regular Alphabets**

You can create a monogram using a regular alphabet by following these steps:

1. Click on the Text tool to display the text dialog box.
2. Select a regular alphabet.
3. Type in the initials.
4. Click on Monogram in the upper right quadrant of the Text dialog box, and the Monogram Parameters dialog box displays (Figure 4-22). The numbers 1, 2 and 3 refer to the letters in a monogram. Set number 2, the middle letter, at a height of 2.0 inches. Change the density, if so desired.
5. Click on OK. Now Monogram is checked in the Text dialog box as an indication that you are in the monogram mode and using a regular lettering alphabet.
6. Click on OK to display the monogram.
5. Working with Designs

Designs as Objects
When EDS EZ draws a design in the Layout window, that design is referred to as an object. Each object is a separate item and maintains its own attributes. This allows you to have a mixture of expanded and condensed designs in the same window.

Using Cut, Copy, Paste, and Clear
The Cut, Copy, Paste, and Clear options are in the Edit menu and can be used with any object in a selection box. The first three options work with the Windows clipboard, which is a temporary memory area.

Cut copies the object to the clipboard and deletes it from the screen.
Copy copies the object to the clipboard but does not delete it from the screen.
Paste copies the contents of the clipboard to the screen.
Clear deletes an object from the screen without copying it to the clipboard. Once an object has been cleared it cannot be recovered.

You can also delete objects by clicking them, then pressing the [DEL] key on the keyboard. As with clear, objects that have been deleted cannot be recovered.

An object remains on the clipboard until you end your EDS EZ session or until you Copy or Cut another object. There can only be one object on the clipboard at a time.
Moving Objects In The Window
Click on the object, and a box with handles appears around it. Click and hold the object within the box (not the box handles) using the left mouse button, and you can move the object anywhere in the active area of the window. You can also move an object in a single axis (either up/down or left/right) by holding down the [Ctrl] key while using the mouse to click and drag.

Double-click on an expanded design and the Object Parameters dialog box (Figure 5-1) appears.

![Figure 5-1](image)

Double-clicking on a Condensed design brings up a different dialog box. You cannot move a Condensed design numerically.

Rotating Objects
Condensed Designs
To rotate a condensed design, click on the object and drag handles appear. Click again and the handles turn into arrows (Figure 5-2). Click on a corner of the design with the left mouse button and drag to rotate the design. The status bar displays the degree of rotation.

![Figure 5-2](image)
Expanded Designs

Expanded designs may also be rotated using the above procedure but may be rotated more precisely using the dialog box. Double-click on an expanded design to display the Object Parameters dialog box (Figure 5-3).

![Figure 5-3](image)

Changing the Orientation of a Design

Sometimes design orientation must be altered for proper results. Figure 5-4 shows the various orientations available.

To change orientation, refer to these instructions.

1. Click on the Object Parameters tool to display its dialog box.

2. Click on the F under Orientation until the desired orientation displays.

3. Click on OK.
Deleting an Object
EDS EZ gives you the flexibility to delete an object in two different ways.

The Layout Window
1. Click on the object.

The Menu Bar
1. Click on the object.
2. Click on Edit in the Menu Bar.
3. Click on Clear.

Centering a Design
The Center Design command recenters your design in the center of the sewing field. You can adjust the placement of the design at the peripheral before you begin to sew, but you should always perform this step before sending a design. To center the design, click on Edit, then Center Design.

Scaling Designs
Condensed designs can be increased in scale by up to a factor of three and reduced by as much as a factor of 0.2. Perform a test sewout if you dramatically change a design’s scale.

Rescaling a condensed design adds or subtracts stitches to or from the design. Rescaling an expanded design does not.
Scaling a Condensed Design

To scale a condensed design, click on the object and drag handles appear (Figure 5-5). Click on a corner of the design with the left mouse button and drag to scale the design. The status bar displays the new relative proportions.

Figure 5-5
Scaling an Expanded Design

Expanded designs may also be scaled using the above procedure but may be scaled more precisely using the dialog box. Double-click on an expanded design to display the Object Parameters dialog box (Figure 5-6).

- Click here to use customized scaling in both X and Y directions (i.e., X=1.5 and Y=0.5)
- Enter the new scale here; if Scale XY is NOT checked, Y will automatically be scaled the same as X
- Click here to apply the new scaling
- Click here to cancel the new scaling

Figure 5-6
Modifying Condensed Designs

EDS EZ allows you to modify the way a condensed design sews. This applies to condensed designs only.

Follow these steps to modify a condensed design:

1. Load a .CND file into the Layout window.
2. Double-click on the object to display the Adjust dialog box (Figure 5-7).

**Figure 5-7**

**Stitching**

**Length**

Length refers to the walking or running stitches used to move from one area of sewing to another. These stitches are usually covered by column stitching.

**Max. Length**

Enter the maximum stitch length up to 127 pts. The default is 127 pts.
Short Stitch On
Short Stitch sews less than the full column width on the inside of a curve or corner. This prevents repeated needle penetrations in one spot. The default is On.

Lock Stitch On
Lock Stitch On sews three small stitches at the end of a letter to tack the stitching. The default is Off. If the design already features lock stitches, enabling this command will add three more.

Column
Density
This is the space in a column between the lines of stitching. The value is entered in points.

Width
Width allows you to increase or decrease the width of the individual column. The height may also be slightly affected. The value can be changed in increments of 10%, from +70% to -70%.

Fills
Fills converts column stitching to fill stitching. Instead of a single stitch across the entire width of a column, there are a series of shorter stitches. Turn on Fills when letters are too large for column stitching to be durable. Fills applies to all Alphabet, Monogram, and Design File column stitches.

Stitch Length
This sets the length of Fill stitches. The default is 40 points.

Line Sequence
When there are multiple stitches in a column, they can sew one directly under the other, or in a staggered pattern. Line Sequence determines where the needle penetrations will be on each line.

Underlay
Turning Underlay On allows you to choose one of the three types of underlay for column stitching. Underlay works with Alphabet, Monogram, or Design files, but will not sew beneath fill stitching.

Stitch Length
Length sets the underlay stitch length for Edge Walk and Center Walk.
Density
This is the underlay density for Narrow Column. The range is 2.6 to 84.7 pts.

Width
This is the underlay width by a percentage of the column width from 40% to 95%. It applies to Narrow Column and Edge Walk underlays.

Scaling
This section allows you to change densities and stitch lengths by a percentage of the existing values. It does not change the overall size of the design.

Density
Density resets column density. Values over 1 increase the density and decrease the stitching coverage. Values less than 1 decrease the density and increase the stitching coverage.

Stitch Length
Stitch Length resets running stitch length based on a scale factor rather than points. A value of 2 doubles the stitch length, a value of .5 halves the stitch length.

Fill Density
Fill Density resets the density of fill stitching. Values over 1 increase the density and decrease the stitching coverage. A value less than 1 decreases the density and increases the stitching coverage.

Fill Stitch Length
Fill Stitch Length resets fill stitch length. A value of 2 doubles the stitch length. A value of .5 halves the stitch length.

Modifying Expanded Designs
Double-click on an expanded object to display the Object Parameters dialog box. Following is a description of the options:

Lock Object
If you have a mixture of text and a design, this will "lock" the objects together.
Trim After
This will place a trim at the end of a design sewout.

Color Change After
This will place a Color Change command at the end of a design sewout.

Design Notes
This feature allows you to add notes to any Object (OFM) file.

Note: This option only works with Object files. It will not work with Expanded or Condensed files.

To access the notes feature, click on File→Notes. The Notes dialog box (Figure 5-8) appears.
Print

This feature allows you to print information about the currently loaded design to a connected printer. To access this option click on File, then Print. The Print dialog box (Figure 5-9) appears.

**Design, Status, and Notes** prints the current design, status, and any notes associated with the design.

**Print Design** prints the current design as shown on-screen.

**Object List** prints the name of all objects within the current design, their location, and orientation.

**Design Status** prints the size, location, and number of stitches (total stitches and total each color), and other information for the current design.

**Notes** prints the notes associated with the current design.

Using the Color Palette

EDS EZ allows you to choose the colors used to draw your designs on the screen. When the palette bar display is on as shown in Figure 5-10, the colors are shown at the bottom of the Layout window. By changing these colors, you get a preview of a sewn garment.

EDS EZ begins drawing with the first color in the palette bar and moves once to the right each time a color-change command is encountered. EDS EZ refers to the colors as "Needle 1", "Needle 2", etc., but they do not control which needles are used at the sewing peripheral.
24 needles are available in the color palette bar. The screen background color is permanently located in the last, outlined box on the right end. The screen color can be changed the same way you control the needle colors.

**Working with the Palette Bar**

In the Layout window, double click any colored square (called “needles”) to display the Needle dialog box (Figure 5-11).

![Figure 5-11](image)

- Displays the color EDS EZ will display
- Name a color (to save it) here
- Click to accept changes
- Click to cancel changes
- Click to save the current color
- Click to delete a selected color
- Shows the relative composition (dithering) of the color
- Use the scroll bars or type in the value to increase or decrease a color's presence

*Figure 5-11*
## Color Information

The Red, Green, and Blue color values are in a range of 0 to 255. To see these colors on a 16-color monitor, enter their numerical values in the needle dialog box.

<table>
<thead>
<tr>
<th>Color</th>
<th>Red</th>
<th>Green</th>
<th>Blue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Red</td>
<td>Red - 255</td>
<td>Green - 0</td>
<td>Blue - 0</td>
</tr>
<tr>
<td>Green</td>
<td>Red - 0</td>
<td>Green - 255</td>
<td>Blue - 0</td>
</tr>
<tr>
<td>Blue</td>
<td>Red - 0</td>
<td>Green - 0</td>
<td>Blue - 255</td>
</tr>
<tr>
<td>Yellow</td>
<td>Red - 255</td>
<td>Green - 255</td>
<td>Blue - 0</td>
</tr>
<tr>
<td>Magenta</td>
<td>Red - 0</td>
<td>Green - 255</td>
<td>Blue - 255</td>
</tr>
<tr>
<td>Cyan</td>
<td>Red - 255</td>
<td>Green - 0</td>
<td>Blue - 255</td>
</tr>
<tr>
<td>Reddish Brown</td>
<td>Red - 128</td>
<td>Green - 0</td>
<td>Blue - 0</td>
</tr>
<tr>
<td>Darker Green</td>
<td>Red - 0</td>
<td>Green - 128</td>
<td>Blue - 0</td>
</tr>
<tr>
<td>Darker Blue (Navy)</td>
<td>Red - 0</td>
<td>Green - 0</td>
<td>Blue - 128</td>
</tr>
<tr>
<td>Ocher (Pale Yellow)</td>
<td>Red - 128</td>
<td>Green - 128</td>
<td>Blue - 0</td>
</tr>
<tr>
<td>Turquoise</td>
<td>Red - 0</td>
<td>Green - 128</td>
<td>Blue - 128</td>
</tr>
<tr>
<td>Violet</td>
<td>Red - 128</td>
<td>Green - 0</td>
<td>Blue - 128</td>
</tr>
<tr>
<td>White</td>
<td>Red - 255</td>
<td>Green - 255</td>
<td>Blue - 255</td>
</tr>
<tr>
<td>Gray</td>
<td>Red - 128</td>
<td>Green - 128</td>
<td>Blue - 128</td>
</tr>
<tr>
<td>Light Gray</td>
<td>Red - 192</td>
<td>Green - 192</td>
<td>Blue - 192</td>
</tr>
<tr>
<td>Black</td>
<td>Red - 0</td>
<td>Green - 0</td>
<td>Blue - 0</td>
</tr>
</tbody>
</table>
6. Working With Files

This chapter covers opening existing files, importing files from other formats, saving new files, and exporting new files to other formats.

Design Formats

Disks come in a variety of storage formats, but EDS EZ considers them as either a hard disk (DOS) or a floppy disk. EDS EZ can access both, but uses different commands with each as shown in the following table:

<table>
<thead>
<tr>
<th>To perform this operation</th>
<th>Use this command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Load design file into EDS EZ</td>
<td>Open or Import</td>
</tr>
<tr>
<td>Save to hard drive (all files saved on the hard drive are DOS formats)</td>
<td>Save or Save As</td>
</tr>
<tr>
<td>Save to floppy disk</td>
<td>Save, Save As, or Export</td>
</tr>
</tbody>
</table>
Opening Designs
Refer to Figures 6-1 and 6-2 to open a file.

Click on File

Click on Open

Click here to display all directories for the specified drive

Select the drive and directory where the file is located

Click on the file name

Click on OK when finished
Importing Designs

Some of the designs you work with may be on a floppy disk. EDS EZ is compatible with DOS, Melco, Premier, Tajima, Barudan FDR and FMC, and ZSK disks, all of which have unique formats. The following chart outlines when to use each command.

To import a design, click on File, then Import. The Import dialog box (Figure 6-3) displays.

![Figure 6-3](image)

Note: If you click on the Options button while working with a Tajima format disk, a message box will ask you if you want to update the Boot Record of the disk. This refers to some Tajima disks that have an improper internal label and cannot be read by a DOS computer. If you have problems loading a Tajima disk, click on the Options button and respond Yes to the message.
Saving Designs

To save a design:

1. Click on File in the menu bar.

2. Click on Save As in the drop-down menu. The Save As dialog box displays as shown in Figure 6-4.

3. Type a name for the design in the Save As File Name box.

4. Select a subdirectory or drive by double-clicking on it in the Directories box. You can move back one level at a time by clicking on [..].

Note: If you do not select a subdirectory, your design will be saved in the EDS EZ main directory.

5. Under File Type, click on Condensed, Object, or Expanded, then click on OK. File types are discussed in later chapters.

The name of your file is now displayed in the EDS EZ title bar. After the file has been named and saved once, you can resave the file and any modifications by clicking on Save.

File Types

The term file type refers to the way design data is coded and named. In EDS EZ there are four file types: Expanded, Condensed, Object, and Auto Send.

Expanded Files

An Expanded design file contains instructions for each individual stitch. Modification of an expanded design is much more limited than modification of a condensed design. Once you save a file as Expanded, you cannot change it to Condensed. Expanded file names have the extension EXP.

Condensed Files

A Condensed file contains summarized design instructions. Its format allows the design to be rescaled and its density and stitch length modified. Condensed file names have the extension CND.
Object Files
An Object file contains information about multiple objects, each with its own separate instructions. For instance, you might combine into one Object file:

- An Expanded design of a team mascot
- A Condensed design of team member’s name

Then, you can modify each object separately. You could rescale the name without altering the mascot. Object file names have the extension OFM.

Auto Send Design Files
An Auto Send Design file is created by EDS EZ when transferring or sending files to a peripheral. In addition to your design data, the file contains special instructions added by EDS EZ to help the peripheral make a sewing recovery after a power failure. Auto Send Design files have the extension ASD.

ASD files are stored in the EDSEZ\ASD subdirectory. To prevent this directory from taking up too much of your hard drive, delete old files periodically using the Windows File Manager. For more information on how to use File Manager, consult your Windows User Manual.

Exporting Designs
Click on File, then Export to display the Export dialog box (Figure 6-5).

![Export dialog box](Figure 6-5)
Note: If you are unsure of the format, click on Unknown, then on the Directory button. EDS EZ will determine the format of the disk and make the selection for you. If you selected a Format Type that does not match the format of the disk, the error message shown in Figure 6-6 will be displayed. If you are still unsure of the disk’s format, click on Unknown.

**File Name Standards**

The filename conventions for floppy disk formats are given below. These rules must be followed for the disk to be read by other systems:

### DOS Format

DOS format names consist of a 1-8 character filename and one of the following extensions:

- .CND - Condensed Format
- .EXP - Expanded Format
- .OFM - Object (Layout format)

### Barudan FDR Format

Barudan FDR uses a numeric format. The file number can be from 1 to 36. In addition, a label of up to 8 characters may be specified with this file number. The number and the label must be separated by a colon.

Examples:

- 3
- 26:SNAIL

### Barudan FMC Format

Barudan FMC uses a numeric format. The file number can be from 1 to 36. No character labels are allowed.

Examples:

- 3
- 26
**Melco Format**

MELCO format names consist of a 1-6 character filename and one of the following extensions:

- CND - Condensed Format
- EXP - Expanded Format

**Premier/Stellar Format**

The PREMIER/STELLAR format uses the Indirect mode of specifying file names (see your Premier or Steller manual for a description of Indirect mode). In general, you can think of a Premier/Stellar filename as a number between 1001 and 1999.

Examples:

- 1001
- 1930

The Options button allows you to specify 5 different sizes for the hardware scaling of the design at sewout time. The defaults are:

- Smallest: 50%
- Smaller: 75%
- Larger: 125%
- Largest: 150%

Enter new sizes as a ratio to 1.00, for example 125% is entered as 1.25

Note: The Stellar 1 can only read files saved in this format. The Premier can read Tajima and DOS (.EXP) files as well.

**Tajima Format**

Tajima format uses a numeric format with numbers ranging from 1-999. Beginning with EDS EZ release 1.32, any 1-8 character name is also supported. In addition to a filename, a 1-8 character label can be specified after the filename and separated by a colon (like the Barudan FDR format.)

Examples:

- 1
- G001 (How the old Tajima format stored the name 1)
- 1:TEST
- APPLE:TEST (The new Tajima Format)
ZSK Format
Zsk format uses a numeric format with numbers ranging from 1-999.

Examples:

1
12
234
7. Working with Peripherals

Enabling the Peripheral
The peripheral(s) must be enabled before a design is sent. To enable the peripheral, Click on File, then Transfer to display the Transfer dialog box (Figure 7-1).

Before sending a design to the peripheral, make sure the following apply:

- The computer network cable is connected to the peripheral
- The peripheral's power is ON
- The peripheral software is downloaded

Note: The peripheral MUST be set to the same number. Refer to the machine Operator manual for information on how to properly configure the machine.
Sending Designs

Designs may be transferred to the peripheral(s) one of two ways.

Using Transfer

Click on Peripheral, then Transfer to display the Transfer dialog box (Figure 7-3).

Select directory

Select file type

Click to return to the Layout window

Click to cancel

Click to send the specified file to the peripheral

Sends the file currently open in the Layout window

Select peripheral where the design will be sent

Select file name

Select whether the design is auto run or auto delete

Figure 7-3
Using Send
Click on File, then Send to display the Send dialog box (Figure 7-4).

Select the peripheral

Click here to automatically queue the design at the peripheral

A name will be selected for the file (as it will appear at the peripheral); to change the default name, type the new name here

Figure 7-4
Checking Peripheral Status

EDS EZ continuously surveys each peripheral for statistical data. This data is available on the Machine Status screen. To access the information click onPeripheral, then Status to display the Machine Status screen (Figure 7-5).

- Displays enabled peripherals and status
- Lists designs in the job queue
- Shows which peripheral is being polled
- Length of time the peripheral has been turned on
- Remaining space in job queue
- Current or last sewing speed
- Color sequence list (99 colors max)
- Color being sewn
- Shows the number of thread breaks
- Length of time the peripheral has sewn
- Name of current or last job
- Length of time current or last job ran
- Stitch count in current or last job
- Indicates percent completed of current job

Figure 7-5
Detail

This option is available for peripherals designed to relay this information. It appears grayed out if it is not available. Click to display the Thread/Bobbin Breaks information screen (Figure 7-6). Thread Breaks: Displays the thread breaks on each needle.

![Figure 7-6](image-url)

- **Reset**: Resets all counters to zero
- **Update**: Updates counters
- **Save**: Saves current counts to an ASCII text file
- **Select counter (by day or by job)**
- **Displays information for each needle**
- **Toggles information displayed above to each different category**
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Actual Size</td>
<td>3-5</td>
</tr>
<tr>
<td>Angle</td>
<td>4-4</td>
</tr>
<tr>
<td>Application Window</td>
<td>3-2</td>
</tr>
<tr>
<td>Arc From Center</td>
<td>4-3</td>
</tr>
<tr>
<td>Arc Normal</td>
<td>4-3</td>
</tr>
<tr>
<td>Attaching the Peripheral</td>
<td>2-3</td>
</tr>
<tr>
<td>Auto Send Design Files</td>
<td>6-5</td>
</tr>
<tr>
<td>Barudan FDR Format</td>
<td>6-6</td>
</tr>
<tr>
<td>Barudan FMC Format</td>
<td>6-6</td>
</tr>
<tr>
<td>Center Design</td>
<td>3-4</td>
</tr>
<tr>
<td>Centering a Design</td>
<td>5-4</td>
</tr>
<tr>
<td>Centering Text</td>
<td>4-7</td>
</tr>
<tr>
<td>Checking Peripheral Status</td>
<td>7-4</td>
</tr>
<tr>
<td>Clear</td>
<td>3-4</td>
</tr>
<tr>
<td>Clockwise</td>
<td>4-4</td>
</tr>
<tr>
<td>Close</td>
<td>3-3</td>
</tr>
<tr>
<td>Color Change After</td>
<td>5-10</td>
</tr>
<tr>
<td>Color Changes</td>
<td>4-6</td>
</tr>
<tr>
<td>Color Information</td>
<td>5-14</td>
</tr>
<tr>
<td>Color Palette</td>
<td>5-11</td>
</tr>
<tr>
<td>Column</td>
<td>5-8</td>
</tr>
<tr>
<td>Condensed Files</td>
<td>6-4</td>
</tr>
<tr>
<td>Configuring EDS EZ</td>
<td>2-5</td>
</tr>
<tr>
<td>Copy</td>
<td>3-4</td>
</tr>
<tr>
<td>Counterclockwise</td>
<td>4-4</td>
</tr>
<tr>
<td>Customized Spacing</td>
<td>4-5</td>
</tr>
<tr>
<td>Cut</td>
<td>3-4</td>
</tr>
<tr>
<td>Cut, Copy, Paste, and Clear</td>
<td>5-1</td>
</tr>
<tr>
<td>Deleting an Object</td>
<td>5-4</td>
</tr>
<tr>
<td>Density</td>
<td>4-2-5-9, 5-8, 5-9</td>
</tr>
<tr>
<td>Design Formats</td>
<td>6-1</td>
</tr>
<tr>
<td>Design List</td>
<td>3-4, 3-2</td>
</tr>
<tr>
<td>Design Notes</td>
<td>5-10</td>
</tr>
<tr>
<td>Design Status</td>
<td>3-5, 5-11</td>
</tr>
<tr>
<td>Design, Status, and Notes</td>
<td>5-11</td>
</tr>
<tr>
<td>Detail</td>
<td>7-5</td>
</tr>
<tr>
<td>DOS Format</td>
<td>6-6</td>
</tr>
<tr>
<td>Edit Menu</td>
<td>3-4</td>
</tr>
<tr>
<td>EDS EZ Help</td>
<td>1-1</td>
</tr>
<tr>
<td>EDS EZ Installation</td>
<td>2-4</td>
</tr>
<tr>
<td>Enabling the Peripheral</td>
<td>7-1</td>
</tr>
<tr>
<td>Exit</td>
<td>3-4</td>
</tr>
<tr>
<td>Export</td>
<td>3-4</td>
</tr>
<tr>
<td>Exporting Designs</td>
<td>6-5</td>
</tr>
<tr>
<td>Topic</td>
<td>Page</td>
</tr>
<tr>
<td>-----------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>File</td>
<td>3-2</td>
</tr>
<tr>
<td>File Menu</td>
<td>3-3</td>
</tr>
<tr>
<td>File Name Standards</td>
<td>6-6</td>
</tr>
<tr>
<td>File Types</td>
<td>6-4</td>
</tr>
<tr>
<td>Fill Density</td>
<td>5-9</td>
</tr>
<tr>
<td>Fill Stitch Length</td>
<td>5-9</td>
</tr>
<tr>
<td>Fills</td>
<td>5-8</td>
</tr>
<tr>
<td>Fit Window</td>
<td>3-5</td>
</tr>
<tr>
<td>Hardware Configuration</td>
<td>2-6</td>
</tr>
<tr>
<td>Hardware Installation</td>
<td>2-1</td>
</tr>
<tr>
<td>Help</td>
<td>3-2</td>
</tr>
<tr>
<td>Import</td>
<td>3-2, 3-4</td>
</tr>
<tr>
<td>Importing Designs</td>
<td>6-3</td>
</tr>
<tr>
<td>Installing the Dongle</td>
<td>2-2</td>
</tr>
<tr>
<td>Layout Window</td>
<td>3-3</td>
</tr>
<tr>
<td>Line Center Bottom</td>
<td>4-3</td>
</tr>
<tr>
<td>Line Center Middle</td>
<td>4-3</td>
</tr>
<tr>
<td>Line Normal</td>
<td>4-3</td>
</tr>
<tr>
<td>Line Sequence</td>
<td>5-8</td>
</tr>
<tr>
<td>Line Spacing</td>
<td>4-6</td>
</tr>
<tr>
<td>Line Type Options</td>
<td>4-3</td>
</tr>
<tr>
<td>Lock Object</td>
<td>5-9</td>
</tr>
<tr>
<td>Lock Stitch</td>
<td>5-8</td>
</tr>
<tr>
<td>Melco Format</td>
<td>6-7</td>
</tr>
<tr>
<td>Modifying Condensed Designs</td>
<td>5-7</td>
</tr>
<tr>
<td>Modifying Expanded Designs</td>
<td>5-9</td>
</tr>
<tr>
<td>Monogram Alphabet</td>
<td>4-8</td>
</tr>
<tr>
<td>Monogramming</td>
<td>4-8</td>
</tr>
<tr>
<td>Mouse Installation</td>
<td>2-3</td>
</tr>
<tr>
<td>Moving Objects</td>
<td>5-2</td>
</tr>
<tr>
<td>Network Options</td>
<td>2-6</td>
</tr>
<tr>
<td>New</td>
<td>3-3, 3-2</td>
</tr>
<tr>
<td>Normal Cursor tool</td>
<td>3-6</td>
</tr>
<tr>
<td>Notes</td>
<td>5-11</td>
</tr>
<tr>
<td>Object Files</td>
<td>6-5</td>
</tr>
<tr>
<td>Object List</td>
<td>5-11</td>
</tr>
<tr>
<td>Oom Out</td>
<td>3-5</td>
</tr>
<tr>
<td>Open</td>
<td>3-3, 3-2</td>
</tr>
<tr>
<td>Opening Designs</td>
<td>6-2</td>
</tr>
<tr>
<td>Orientation</td>
<td>5-3</td>
</tr>
<tr>
<td>Palette Bar</td>
<td>5-12</td>
</tr>
<tr>
<td>Paste</td>
<td>3-4</td>
</tr>
<tr>
<td>PCB</td>
<td>2-1</td>
</tr>
<tr>
<td>Command</td>
<td>Page Numbers</td>
</tr>
<tr>
<td>------------------------------</td>
<td>--------------</td>
</tr>
<tr>
<td>Peripheral</td>
<td>3-2</td>
</tr>
<tr>
<td>Peripheral Menu</td>
<td>3-5</td>
</tr>
<tr>
<td>Premier/Stellar Format</td>
<td>6-7</td>
</tr>
<tr>
<td>Print</td>
<td>3-4, 5-11</td>
</tr>
<tr>
<td>Print Design</td>
<td>5-11</td>
</tr>
<tr>
<td>Printed Circuit Boards</td>
<td>2-1</td>
</tr>
<tr>
<td>Printer Setup</td>
<td>3-4</td>
</tr>
<tr>
<td>Radius</td>
<td>4-4</td>
</tr>
<tr>
<td>Regenerate</td>
<td>3-5</td>
</tr>
<tr>
<td>Return to Origin</td>
<td>3-4</td>
</tr>
<tr>
<td>Rotating Objects</td>
<td>5-2</td>
</tr>
<tr>
<td>Ruler</td>
<td>3-5</td>
</tr>
<tr>
<td>Ruler tool</td>
<td>3-6</td>
</tr>
<tr>
<td>Save</td>
<td>3-3</td>
</tr>
<tr>
<td>Save As</td>
<td>3-4</td>
</tr>
<tr>
<td>Saving Designs</td>
<td>6-4</td>
</tr>
<tr>
<td>Saving Text Designs</td>
<td>4-7</td>
</tr>
<tr>
<td>Scaling</td>
<td>5-9</td>
</tr>
<tr>
<td>Scaling an Expanded Design</td>
<td>5-6</td>
</tr>
<tr>
<td>Scaling Designs</td>
<td>5-4</td>
</tr>
<tr>
<td>Send</td>
<td>3-4, 7-3</td>
</tr>
<tr>
<td>Sending Designs</td>
<td>7-2</td>
</tr>
<tr>
<td>Short Stitch</td>
<td>5-8</td>
</tr>
<tr>
<td>Show Zoom Factor</td>
<td>3-5</td>
</tr>
<tr>
<td>Software Installation</td>
<td>2-4</td>
</tr>
<tr>
<td>Spacing</td>
<td>4-5</td>
</tr>
<tr>
<td>StarGate Options</td>
<td>2-6</td>
</tr>
<tr>
<td>Starting EDS EZ</td>
<td>3-1</td>
</tr>
<tr>
<td>Status</td>
<td>3-5</td>
</tr>
<tr>
<td>Status Bar</td>
<td>3-5</td>
</tr>
<tr>
<td>Stitch Length</td>
<td>5-8, 5-9</td>
</tr>
<tr>
<td>System Requirements</td>
<td>2-1</td>
</tr>
<tr>
<td>Tajima Format</td>
<td>6-7</td>
</tr>
<tr>
<td>Text Dialog Box</td>
<td>4-1</td>
</tr>
<tr>
<td>Text tool</td>
<td>3-6-4-1</td>
</tr>
<tr>
<td>Tool Bar</td>
<td>3-5</td>
</tr>
<tr>
<td>Toolbar</td>
<td>3-6</td>
</tr>
<tr>
<td>Transfer</td>
<td>7-2</td>
</tr>
<tr>
<td>Trim After</td>
<td>5-10</td>
</tr>
<tr>
<td>Trims</td>
<td>4-6</td>
</tr>
<tr>
<td>Underlay</td>
<td>5-8</td>
</tr>
<tr>
<td>Uniform Spacing</td>
<td>4-5</td>
</tr>
<tr>
<td>Vertical Spacing</td>
<td>4-6</td>
</tr>
<tr>
<td>View Men</td>
<td>3-5</td>
</tr>
</tbody>
</table>
Width ................................................5-8, 5-9

Zoom In .............................................3-6, 3-5
Zoom Last .............................................3-5
Zoom Out .............................................3-6
Zoom Previous.....................................3-6
ZSK Format .......................................6-8
Create Lettering
1. Click on File.
2. Click on New.
3. Click on the Text tool.
4. Type in your lettering.
5. Choose Alphabet and other parameters
6. Click on OK.

Adjust Lettering
1. Double-click on the lettering.
2. Make the necessary adjustments.
3. Click on OK.

Open a Hard Disk File
1. Click on File.
2. Click on Open.
3. Choose the directory, file type, and design name. Examples: A:boat.cnd, B:flower.exp, C:\edsez\designs\july.ofm
4. Click on OK.

Import a Floppy Disk file
Melco, DOS, Premier, Barudan, Tajima, ZSK, or Unknown
1. Click on File.
2. Click on Import.
3. Select Format type.
4. Choose the Directory and design name.
5. Click on OK.

Adjusting the Design
1. Click on the design and a box forms around it.
2. Double-click on the design and a dialog box appears.
3. Make the necessary adjustments.
4. Click on OK.

Move a Design
1. Click on the design and a box forms around it.
2. Click and hold anywhere within the box.
3. Drag the design anywhere within the Layout window.

Rotate or Scale a Design
1. Click on the design and a box forms around it.
2. Click and hold on one of the box handles.
3. Drag the handle to change the design.
NOTE: For Expanded designs, double-click on the design to rotate or scale.

Center a Design
1. Click on Edit.
2. Click on Center Design.

Save a Design
1. Click on File.
2. Click on Save As.
3. Choose the directory, file type, and design name. Examples: A:boat.cnd, B:flower.exp, C:\edsez\designs\july.ofm
4. Click on OK.

Export a Floppy Disk file
Melco, DOS, Premier, Barudan, Tajima, ZSK, or Unknown
1. Click on File.
2. Click on Export.
3. Select Format type.
4. Choose the Directory and design name.
5. Click on OK.

Send a Design to the Peripheral
1. Click on File.
2. Click on Send.
3. Choose which machine will sew it.
4. Click on OK.

Transfer a Design to the Peripheral
1. From the Application window, click on Peripheral
2. Click on Transfer.
3. Choose File Type (EXP or ASD)
4. Choose which machine will sew it.
5. Choose the directory.
6. Select one or more files to send.
7. Click on Send.

To View the Design Status Data
Design must appear on-screen
1. Click on View.
2. Click on Design Status.
3. Click on OK when done.

Stitch Density Chart

<table>
<thead>
<tr>
<th>Points</th>
<th>Stitches Per Inch</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.4</td>
<td>105.8</td>
</tr>
<tr>
<td>2.6</td>
<td>97.6</td>
</tr>
<tr>
<td>3</td>
<td>84.6</td>
</tr>
<tr>
<td>3.4</td>
<td>74.7</td>
</tr>
<tr>
<td>3.6</td>
<td>70.5</td>
</tr>
<tr>
<td>4</td>
<td>63.5</td>
</tr>
<tr>
<td>4.4</td>
<td>57.7</td>
</tr>
<tr>
<td>4.6</td>
<td>55.2</td>
</tr>
<tr>
<td>5</td>
<td>50.8</td>
</tr>
<tr>
<td>5.4</td>
<td>47.0</td>
</tr>
<tr>
<td>5.6</td>
<td>45.4</td>
</tr>
<tr>
<td>6</td>
<td>42.3</td>
</tr>
<tr>
<td>6.4</td>
<td>39.6</td>
</tr>
<tr>
<td>6.6</td>
<td>38.5</td>
</tr>
<tr>
<td>7</td>
<td>36.3</td>
</tr>
<tr>
<td>7.4</td>
<td>34.3</td>
</tr>
</tbody>
</table>